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STEERING COMMITTEE HIGHLIGHTS:

Treasurer’s Report (3/31/2008):
Total Assets $5,728.51

Positions needed:
Equipment — Purchase, maintain and set up
equipment for meetings

Historian — Maintain and archive papers of

Computer Interest Group
* * * * * *

UPCOMING CGS/CIG PROGRAMS:
All Monday CIG meetings are held at:
Christ the King Lutheran Church,

2300 So. Patton Ct., Denver, Colorado

Monday, May 12, 2008 at 7:00 p.m.
Workshop Meeting

Monday, June 9, 2008 at 7:00 p.m.
Speaker: Don Elliott
"Indexing"

* * * * * *

UPCOMING CGS PROGRAMS:
All Friday night programs held at:
Christ the King Lutheran Church,
2300 S. Patton Ct., Denver, Colorado

Friday, May 16, 2008 at 7:00 p.m.
Speaker: Annette Bottello

“Ildentity Crisis: Pinning down the
Shifting Sands of West Virginia”

A case study using indirect evidence to
solve the problem

Friday, June 20, 2008 at 7:00 p.m.
Annual CGS Potluck Dinner and Annual
Meeting

Speaker: Bobbi King

“Researching in Nebraska”
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Report of the Nominating Committee

The following individuals have agreed to serve
as officers of CIG for 2007-2008, if elected by

the membership. Anyone wishing to nominate
other candidates may do so at the membership
meeting when elections occur. We are grateful
for the willingness of these individuals to serve.

President: Vern Tomkins

Vice President: Sandy Ronayne
Treasurer: Ray Henney
Secretary: Bob Shankland

Everyone knows Vern and Bob as they
continue in their same positions.

Meet Sandy Ronayne: “Belonging to CIG and
CGS has helped me in researching my family.
| started researching in 2001 and would not
have been so successful without the guidance
that programs at both groups presented. |
learn something new everytime | attend a
program and talk with other researchers.”

Meet Ray Henney: "My interest in family
history began as a teenager when | found an
envelope in my paternal grandfather's photos.
It was marked "Keep" and contained the family
chart back to the 1750's. Ten years later, | had
many opportunities to talk to my maternal
grandmother who told me about her family.
While | have worked off and on with my
research, | am a recent member of both the
CGS and CIG. The CGS lectures have greatly
helped me organize my research and CIG has
introduced me to a number of good software
packages. | plan to spend many days working
on family history after | retire next year.

My career has been in accounting or finance
with the Walt Disney Company, Time-Warner
Cable and currently with Peregrine, a small
engineering company. | look forward to
helping the CIG group as treasurer.”

We still seek a full slate of 3 nominating
committee members.

Current Nominating Committee: Sandy Carter-
Duff, Iris Hawkins and Bill Stephens
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New CIG website Address

www.rootsweb.ancestry.com/~cocgs/cigmain.htm

The Computer Interest Group of the Colorado
Genealogical Society has a new website
address. Due to the merger of Rootsweb and
Ancestry, "Ancestry" has been added to our
web address.

Information about our program and workshop
meetings are available on the site.

How | Used Free Websites to
Uncover My Uncle’s Past

By Zoe von Ende Lappin

My uncle Stanford died in an institution
for alcoholics in Connecticut in 1964. He
worked as an orderly there. That's what my
mother, his sister, told me. Later, his wife, Aunt
Naomi, gave me the exact date and place —
September 7, 1964, in Newtown, Connecticut.
She said nothing about demon booze, but |
knew that he'd had a problem.

That was all | knew until early in 2008
when | decided to get serious about Uncle
Stan. | knew a lot about his early life — birth
date and place, marriage date and place, birth
dates and places of his two children, jobs he
held as a young man. But | knew very little
about him after he left our hometown in
Wisconsin in 1940 to live first in Brooklyn and
then in Connecticut. He and his family came to
visit a few times, my grandparents went East to
see them, and | knew that he'd had a difficult
time late in life. He and Aunt Naomi were
divorced.

Page 3

May-June 2008

Dear Aunt Naomi had passed on in
2002, and for touchy personal reasons, | was
reluctant to contact their children. So, | went to
the Internet, my first resource of choice these
days. As you shall see, | was richly rewarded
and everything | found was on free Web sites.
(I used an Ancestry.com subscription site only
once, and that at the Denver Public Library
where it's free to registered patrons. And, |
paid $10 for a copy of his death certificate.)

First, | set about to see if | could find his
death certificate. That's when | consulted
Ancestry.com at the library, using the
Connecticut death index, 1949-2001. By
entering his full name, Stanford Nugent, | got
nothing. Then I tried just Nugent and the year,
and there it was with his first name misspelled
Stanfor. The death date and places matched
those his former wife had given me,
September 7, 1964, at Newtown, Fairfield
County, Connecticut. The index told me he
was a resident of Milford, New Haven County,
Connecticut. It gave the state file number. |
printed the index item (10 cents a page at the
DPL) in preparation for sending for a copy of
the complete death certificate. | knew that
Connecticut death records are filed by town,
not county, so at home | went online to learn
the address of the Newtown town clerk and to
read instructions on obtaining a copy of the
death certificate. | did that by asking Google to
find Newtown Connecticut town clerk, and it
popped up immediately. | clicked on Vital
Records, followed the directions, and sent off
my money order for $10. That was at the end
of January 2008.

While waiting for the death certificate, |
reviewed my grandmother’s old address book
and made a timeline for Uncle Stan and Aunt
Naomi. Grandma didn't always date her
entries, but | found two for her son Stan, in
1958 and 1960, in Milford, Connecticut — 798
Bridgeport and 6 Center Street. It appeared
that he and Naomi had divorced before 1958,
for she was back in her hometown in New York
by then, and Grandma had entered my aunt’s
new address.
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It took less than two weeks for the
death certificate to arrive. It stated Uncle Stan
had died at Fairfield Hills Hospital in Newtown,
and was a resident of 6 Center Street in
Milford, matching the information in Grandma'’s
address book. The doctor who signed the
death certificate, Jane E. Oltman, M.D., stated
that “we” — not “I” — had treated him from April
13, 1961, to the date of his death, September
7, 1964, and that she had last seen him the
day before he died. The cause of death was
pulmonary infarction (lung disease, possibly
caused by a blood clot) with cirrhosis of the
liver given as a secondary condition. | knew
the latter was usually associated with chronic
alcoholism; the death certificate thereby
confirmed part of my mother’s story.

At this point, | made three wrong
assumptions, though they didn't throw me off
the track for too long. First, | assumed that the
address in Milford, 6 Center Street, was that of
the institution my mother spoke of. Second, |
assumed that Fairfield Hills was a general
hospital. Third, | assumed that my uncle been
a patient periodically at Fairfield Hills over the
3% year period given on the death certificate,
always returning to the address in Milford.

None of those were correct, but | didn’t
know that until farther along in my research.
Wisely, | decided to test my assumptions. First
— how could | learn what actually occupied 6
Center Street in Milford, Connecticut? | e-
mailed a city office and the historical society
without satisfactory answers. | also went to my
favorite Web sites, message boards at
Rootsweb.com <http://boards.rootsweb.com/>
and Genforum at Genealogy.com
<http://genforum.genealogy.com/> | posted the
same message in three places: the New
Haven County, Connecticut, message board at
Rootsweb, plus the New Haven County and

the Connecticut statewide forums at Genforum.

My query was headed “Address Help in
Milford,” and read:

“My uncle was a resident of 6 Center
Street in Milford when he died in 1964. Can
anyone tell me what that was? Some sort of
institution such as a hospital or rest home, or a
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private home or apartment? | understand he
was working as an orderly in some type of
institution. He actually died in a hospital in
Newtown, CT."

| received no replies to the Rootsweb
posting (no surprise for that's a cumbersome
site), but three gems appeared on Genforum
(far easier to browse and use). First was this
friendly response from Judy G:

“He was an orderly at an institution?
Was that in Newtown? In which case it might
have been Fairfield Hills Hospital. This was a
very large state psychiatric facility. My uncle
worked in the dairy there. Sorry, don't know
about the Milford address.”

Aha! The institution my mother
mentioned must have been Fairfield Hills, not
some unknown facility in Milford. It all made
sense. Further examination of the death
certificate showed that the details came from
hospital records, which would have been made
at the time of his admission, either by Uncle
Stan himself or a family member, probably his
former wife. (Even though he and Aunt Naomi
were divorced, she looked after him until the
end of his life. She was a magnanimous
woman whose kindness for his family showed
itself over and over throughout her long life.) It
was logical to assume now that he had lived in
Milford at the time of his admission, and that
the time frame covered in the period at which
he was treated actually referred to the time he
was institutionalized at Fairfield Hills.

Next, it was Google again. Asking for
Fairfield Hills Hospital Connecticut, | was
rewarded with a Web site
<http://www.fairfieldhills.com/> which is run,
apparently, by a couple of historians fascinated
with the place. They call it “The Lost Asylum.”
It was, indeed, a huge state psychiatric
hospital which had more than more than 4,000
residents on 770 acres at its peak. The state
closed it in 1996.

Back to Google for the doctor who
signed his death certificate, Jane E. Oltman,
M.D. A total of 89 entries turned up, and the
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third one, a 1960 article in the American
Journal of Psychiatry, identified Dr. Oltman, a
co-author, as clinical director, Fairfield State
Hospital, Newtown, Connecticut. Uncle Stan
had been under the care of a psychiatrist, and
the “we” on the death certificate applied to the
hospital staff.

To learn more about the doctor, | went
to the Research Resources page on the
Denver Public Library Web site, clicked on
Databases A-Z, then on America’'s Obituaries
and Death Notices (free to library cardholders).
| entered her name, didn't bother with a
locality, and found five obituary entries in 2006,
all from Connecticut. They described her
service at Fairfield Hills, and | learned she had
lived to be 96 years old.

Meantime, two other people responded
to my Genforum queries. Both referred me to a
Website on which | could actually see what the
building at 6 Center Street in Milford looks like
today. It's called Vision Appraisal Technology
at
<http://www.visionappraisal.com/databases/>
which serves seven eastern states. Following
the links, | learned that 6 Center Street is a
single-family, two-story home built in 1900,
now assessed at $258,610. It's a large house
with a partial wrap-around porch, vinyl siding
and a garage. It could have been a boarding
house when Uncle Stan lived there in 1960. It
most definitely was not a public institution as |
had once erroneously assumed.

Everything now fell into place, but there
was one last source to consult: Fairfield Hills
Hospital records housed at the Connecticut
State Archives. Google quickly took me to its
home page, <http://www.cslib.org/archives/>
and after a few fits and starts, | opened to
Finding Aids. There, | scrolled to Record Group
21, Department of Mental Health and Addiction
Services, 1866-1994. It had a link to records of
Fairfield Hills Hospital, Series 7, 1933-1976,
just the place and time period | needed. The
catalog suggests that Uncle Stan’s records
might be in that group, but also states the
records are restricted. | found an e-mail
address to the archives, a phone number, the
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name of the state archivist and his U.S. Mail
address.

| assumed | would never see the
records, but | could not let the matter rest. I've
been wrong before. | believed | needed a
source other than the circumstantial evidence
on his death certificate and my mother’'s vague
recollection to show that he was a resident at
Fairfield Hills Hospital, and I'd also like to know
the circumstances of his committal and a
diagnosis. | e-mailed and left a telephone
message without a reply. Finally | sent an old-
fashioned paper letter by U.S. Mail. That was
in early March.

In less than a week, a rather apologetic
state archivist responded, by e-mail, and he
could offer almost no help. Fairfield Hills’
chronological log books still exist, he said, but
they are not indexed or alphabetized. All he
could do would be to check my dates to
confirm or refute Uncle Stan’s date of
admission and death. If the ones on the death
certificate are incorrect, the archivist could do
no more. Almost all case files have been
destroyed, so there’s no way he could find the
details of my uncle’s commitment or the nature
of his illness. | decided I'd accept the dates on
the death certificate, and let the matter rest.

Even though | did not learn every detail
that | was hoping for, | consider this Internet
search most successful. It took a little over a
month to gather my information. Three cheers
for people who answer queries and respond to
postings. Those that | received in response to
“Address Help in Milford” made me vow to
frequently visit sites devoted to surnames and
localities with which | am familiar, and to
always respond to the serious-sounding ones |
can help.

(Note: Stanford and Naomi Nugent are
not my uncle and aunt’s real names. | have
changed them to protect their anonymity.)
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Lineage Societies,
Hereditary Societies,
Family Associations and
One-Name Societies

by Bill Nix

The benefits of belonging to a Hereditary
Society, Lineage Society or an Organization
Requiring Members to submit documented
Family History data are:

Preparing the application for such a society requires
one to organize his/her family history and to
accumulate considerable reliable documentation
regarding specific person and life events.
Organizing family history data is beneficial.

The prestige of belonging to a respected society
can benefit its members. Depending upon the
organization, members can be involved in the
preservation of their nation’s history, in significant
charitable work, and be volunteers active in
worthwhile efforts.

Organizations can provide access to significant
genealogical resources. Some societies have
extensive family history related libraries. Some
provide, for a fee, copies of application records that
contain documented evidence pertaining to
individuals and events.

When members qualify to become a member of one
of these organizations the family history information
that is provided is a matter of record with a reliable
and safe repository. Therefore, member’s family
history is available for the benefit of future
generations.

Think for a moment of the special benefit you and
your descendants may acquire when you join a
Family DNA Project. So many of us are now
struggling to have persons who share or may share
our DNA tested in order to help us with our
genealogical research. DNA that is on file with a
responsible DNA lab can benefit lots of people in so
many ways.

Some of these “societies” publish books that
contain member’s genealogies. Such books are of
great benefit to families, historians and
genealogists.
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Favorite Websites for Lineage Societies,

Hereditary Societies, Family
Associations and One-Name Societies

Cyndi's List is a great website to begin your
research into lineage societies, family
associations and other groups. These four
websites offer links:

http://www.cyndislist.com/soc-lineage.htm#First
Lineage Societies

http://www.cyndislist.com/surnames.htm
Family Associations

http://www.cyndislist.com/surn-dna.htm
DNA Surname Projects

http://www.cyndislist.com/soc-gen.htm
Ethnic groups, Military, National Societies,
Religious Societies

Other websites:
http://www.hereditary.us/chrono.htm
Hereditary Societies Listed by Chronology of
Years Founded

http://www.genealogy-
guest.com/collections/lineagesoc.html
Lineage Societies accept members based
upon lineal descent from a specific group of
ancestors. This list provides the names of
some of those ancestors and the society that
may accept you if you are able to prove direct
descent.

http://www.rootsweb.ancestry.com/~coccgs/Council
-familyrecognition.htm
Colorado Family Recognition Program

The Colorado Council of Genealogical
Societies offers recognition of persons whose
families settled in Colorado. There are three
categories of certificates: First Family,
Territorial and Centennial.
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Genetic Genealogy

B by Earl Beaty
% The workhorse for genetic

genealogy is the tests on a
man's Y chromosome. The test
results are a table of numbers
each indicating the number of times a
bit of genetic material has been
repeated at selected locations. These
numbers of repeats are not good for
anything except providing a measure
of how the testee is related to other
men. Relating those numbers to
genealogy is not totally easy. At the
May workshop we will be discussing
the issues surrounding this problem.
Here is a brief overview:

The simplest measure of how two men
are related is the "genetic distance". In
most cases this is just the number of
differences in the two haplotypes.
There are some more complex parts to
the overall calculation but the testing
companies supply the answers and it
is best for the customers just to take
their word for it. The idea is that if the
genetic distance is large the two men
can consider themselves "unrelated". If
the genetic distance is small then
there is a likely a rather recent
common ancestor. The difficult
questions here are: How large? and
How recent?

A common and better use of DNA
testing involves a known common
ancestor for whom results are
available on several of his
descendants. The value is that it can
provide a way to check the
genealogical conclusions. Who is
really a descendant of the "known"
ancestor? Sometimes people make
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mistakes in their genealogy. The
easiest way to address this is to get
together with the other descendants
and share information. The problem is
inherently statistical and it is best if
someone in the group is comfortable
with statistical information. If a
suitable ancestor is not known, the
thing to do is search for matches in
some of the large public databases. By
far the best place to look for matches
is with men of your own surname.
Some of the testing companies help to
organize surname projects.

Earl runs the DNA class at Workshop Meetings

Understanding $ymbols in
Old Documents

http://www.jelleyjar.com

Initials:

a.a.s. - died in the year of his/her age (56
years died in 1856)

d.s.p. - died without issue

d.s.p.l. - died without legitimate issue

d.s.p.m.s. - died without surviving male issue

d.s.p.s. - died without surviving issue

d.unm. - died unmarried

d.v.p. - died in the lifetime of his father

d.v.m. - died in the lifetime of his mother

et al - and others

F.L.T. - friendship, love and truth

Inst - present month

Liber - book or volume

Nepos - grandson

Nunc Nun - an oral will, written by a witness

Ob - he/she died

Rel. or Relict - widow or widower

Res. or Residue - widow or widower

Sic - exact copy as written

Testes - witnesses

ult - late

Ux or vs - wife

Viz - namely
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Get the Children in Your
Lifelnterested in Family
History

Family Tree Magazine has a website especially
for kids. It includes:

Family Tree Fun (word search — word
scramble)

Family Detective — Junior Tool Kit

My Family Tree - a colored form for kids to
download and fill in names and birthdate of
parents-grandparents and greatgrandparents,
then print. You might even want to fill it in and
print it yourself:

my ¥am|ly tree
4 £
o 5 /{/
M e

/

http://kids.familytreemagazi ne.com/default.asp

?? Ask An Expert ??

Do you have a question about your computer
genealogy program? Digital imaging or
scanning? DNA research? Internet research?
This columnisfor you. No question istoo
simple. Maybe someone else is wondering the
same thing.

Email your question to the editor at
LKD41654@aol.com and it will be forwarded
to one of our workshop leaders. Then, watch
for your question and answer in upcoming
newsletters.
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Computer Tip
Saving Web Page Text

When copying information from a website, you
may want only the text. To avoid copying
images and other unwanted items, saveit asa
text file.

1. Open the Web page you want to copy text
from and select File>Save As.

2. Select Plain Text (*.txt) in the Save astype
field.

3. Create afile name and click Save.

An alternate method is to copy and paste the
information directly into aword processing or
genealogy program as unformatted text.

1. Inthe Web page, highlight the text with
your mouse and copy it. (Press Ctrl+V; select
File>Copy; or right-clock the highlighted text
and select Copy.)

2. Open your word processing program or
other program where you want to paste the text.

3. Go to the Edit Menu and select Paste
Special>Unformatted Text, or asimilarly
worded option.

Above taken from Rootsweb Review, Vol. 11, No. 14

Fa’chers Dag
June 15,2008
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M eeting L ocation

The Monday meetings are held at 7:00 pm at Christ
the King Lutheran Church, 2300 So. Patton Ct., in
southwest Denver. The churchis at the corner of
[liff Ave. and So. Patton Ct. in the Harvey Park
area.

When coming from the north: Take Federal or
Sheridan Blvd. south to Evans Ave. Turn right
from Federal or left from Sheridan and take Evans
to Patton Ct. Turn south on Patton Ct. two blocks
to the church at Iliff Ave.

When coming from the south: Take Federal or
Sheridan Blvd. north to Yale Ave. Turn left from
Federal or right from Sheridan and take Yaeto
Patton Ct. Turn north on Patton Ct. three blocks to
the church at Iliff Ave.

2300 g Fntton Et.

Denver, CO 80219

W. Jewell Ave 1900 S

North

:

&
PAIg [e12pay] 'S

f/‘
(

“pajg uepuays s |
o
‘M 000E

Y
10 uoned ‘s

2300
T

W. Yule Ave,

2700 S.

M 00ZS

Mothers’ Day

May 11,2008

MEMBERSHIP ROSTERS

CIG Members may request amembership
roster from Membership Chairman, Charlotte
Weller by emailing her at
charjweiler@yahoo.com. A roster of specific
genealogy program usersis also available.
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ZFrom the Editor:

Please help make this newsletter a success by
submitting articles relating to computer
genealogy to meto include in this newsletter.
Please be generous with your submissions of
your favorite geneal ogical websites, a new
website you have discovered, breakthroughs
using your computer, and genealogical news
and meetings of other societies.

Articles may be emailed to me at
LKD41654@a0l.com. Deadlinefor articlesis
the 25™ of even-numbered months. Next
deadlineis August 25, 2008.

Thank you for your help,

Lynette Dick

Steering Committee Elected Officers

President............... Vern Tomkins.............. 303-922-3639
Immed. Past Pres...... Patrick Purcell..............303 -973-2185
Vice President.......... Bill NiX....oooovvniinnne, 720-981-2934
Secretary................ Bob Shankland............ 303 -986-8583
Treasurer................ Charlotte Weiler........... 303 -989-5079

Steering Committee A ppointed Officers

Membership........... Charlotte Weiler............ 303 -989-5079
Equipment.............. Earl King............cce.. 303 -795-1150
Publicity/Bylaws ....Mike Roman............... 303 -504-4314
Newsletter.............. Lynette Dick............... 303 -986-7910
Hospitality............. Lynette Dick................ 303.986 -7910
Programs............... Bill NiX...ooooevineiene, 720-981-2934
CGS Liaison........... Nancy Ratay................ 303 -972-2701
Council Liaison....... Charlotte Weiler............303 -989-5079

Nominating Committee

Sandy Carter-Duff, Iris Hawkins, Bill Stephens

Workshop L eaders

Family Tree Maker...Ed Richard................ 303 -355-2592
The Master Geneal ogist

Birdie Holsclaw............ 303 -530-4054

Patrick Purcell,................. 303-973-2185

Bobbi King................. 720 -839-4952
Legacy............... Vern Tomkins............... 303 -922-3639
Scanning & Digital Imaging...Gary Ratay...... 303 -972-2701
Roots Magic......... Jamie Redmond............. 303 -751-9075
Reunion for Mac....Nancy Ratay................. 303 -972-2701
DNA.....ccoviee. Earl Beaty.................... 303 -494-8713
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